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This manual will introduce you to the CIC Business Manager - Supervisory tool. In this manual you will be 
introduced to the Supervisor environment, how to create and manage views and how to display reporting data 
in meaningful ways.
This material is meant only for those individuals that have Supervisor Access to the CIC program. If you need 
access please contact the IT Service Desk at 614-688-HELP(4537) or 8help@osu.edu
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Accessing Business Manager

The Business Manager - Supervisor program will be installed separately on your computer 
from the CIC Client. To open the Business Manager application you will need to launch the pro-
gram from the start menu or by double clicking the icon.Note:

Not everyone has 
access to this applica-
tion. Special permis-
sions are needed to 
log in. You will need to 
contact the IT Service 
Desk if you feel you 
need access and you 
do not currently have 
it.

The log in screen will require your username, password and server information.

For the username you will enter your Lastname.FirstName CIC Username.
Your password will be the current password.
Server will be the current CIC Server. If you have any questions or concerns please contact your 
supervisor or the IT Service Desk at 614-688-HELP(4357).

Introduction

The first time you log in you will see the Getting Started screen. From here you can navigate 
anywhere and there are multiple places you can go.
Within the Call Interaction Client there are limited monitoring capabilities. Business Manager 
- Supervisor however is far more powerful, summarizes additional operational statistics and 
provides an alerting system.
From within the Supervisor instance you can:

• Monitor individual agents
• Monitor multiple agents
• Monitor single workgroups
• Monitor multiple workgroups
• Set alerts to inform of events triggered by statistical changes
• View real time data in graphs and consolidated tables
• Respond to agent Assistance requests
• Run Interaction Reporter
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Introduction Introduction

Supervisor is a component of the IC Business Manager and is used to manage and monitor your 
Service Desk in different ways. When you start IC Business Manager for the first time the main 
page will be blank or you will be presented with the Getting Started space.
Your role is to create your own views and modify the workspaces to fit your needs. Whenever you 
add a view they will appear in the IC Business Manager workspace as tabs by default.
Once views are created and arranged the workspace will be “remembered” upon exiting and re-
entering Supervisor.
To sum up the interface, Workspaces are a collection of Views. You decide what Views you want 
to include within the different Workspaces.
Workspaces are represented by tabs or buttons along the left. Within each Workspace Views are 
represented by tabs across the top of the Workspace.

There are many different types of Views that are available along with reports and feedback tools. 
Even if a specific item is not listed in this manual there is a robust Help feature of the Supervisor 
tool available for your use. You can find details on:

• Historical Reports
• Interaction Feedback
• Interaction Recorder
• Interaction Report Assistant
• Interaction Reporter
• Interaction Supervisor
• Interaction Tracker
• Optimizer Administration etc...

The Help feature can be access through the Help Menu at the top of the screen
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Workgroup Views

Supervisors will have the ability to add new Views to Workspaces that allow them to see the 
details of workgroups or agents.
1. Select New
2. Select View
3. Set Group By to Categories
4. Select Agents and Workgroups
Once you are in the Agents and Workgroups category you will see a listing of many different 
Views that are available.

• Agent Details
• Agent Graph
• Agent or Workgroup Queue
• Agent Overview
• Workgroup Details
• Workgroup Directory
• Workgroup Graph
• Workgroup Overview
• Workgroup Statistics

Introduction

The default layout does have a collection of predefined Workspaces with some  Views already 
set.

This is the Home Workspace and by default displays the Getting Started View. You 
may leave this workspace as is or add additional views to it.

Interaction Recorder Workspace is used to search and playback recordings such 
as phone calls, Web chats, e-mails, and screen recordings. It can also used to score 
recordings and search and view scorecards. You may leave this workspace as is or 
you may decide to add more Views.

Interaction Reporter Workspace allows you to generate pre-defined reports. Using a 
report Filter, simply configure the report parameters and run the report. Report Filters 
can be saved to be used again, and a filter can also be exported to a file. You may 
leave the workspace as is or you may add additional Views.

Interaction Reporter will be explained in more detail later.
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Workgroup Views - Agent Overview

The Agent Overview view allows you to see the statistics of several agents in one or more work-
groups.
1. From the listing of possible Views select Agent Overview and click the OK button.
2. This will open the Agent Overview window showing the different workgroups available. 
3. Select the workgroup where the agent belongs or select [All] to see all of the agents in 

the workgroup.
Please keep in mind that if you have access to many different groups you will have to filter the list 
using the text field at the top. For example if I am looking for a Workgroup in the OCIO I would 
type OCIO in the filter field to find the correct group.
4. Click the Next button.

Workgroup Views - Agent Overview

This will display a window allowing you to select the agent(s) you would like to see.
Select the entry from the left and click the Add button in the middle.
Alternatively you could click the Add all button to see all the agents.

Once your selections have been made you can click the Next button to move forward.
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Workgroup Views - Agent Overview

The next screen allows you to choose the interval and the statistics that you would like to see in 
the view. By default all intervals are added. You will need to remove any intervals that you do not 
need.
There are no queue statistics added by default.
You will need to select the statistics you would like to see in the view and click the Add button.
Alternatively you can click the Add all button but please keep in mind the more you add to the 
statistics the more cluttered your screen will be.

Once you have made your selections you will need to click the Finish button to complete the 
view.
In this example I have added 5 agents from the OCIO_ITSD Workgroup and I am looking at the 
Intervals of Current Shift and Current Period. The stats I chose to display are the Interactions 
received, Interactions completed and Average talk time.
The View is added to the Workspace you are on when you create the new view, so in this case it 
is added to the Default Workspace.

Workgroup Views - Agent Overview

Interval Statistics
Current Period
Current Shift
Previous Period
Previous Shift

Queue Statistics
Interactions Received
Interactions answered
Interactions completed
Longest interaction waiting
Longest talk time
Average wait time
Average talk time

Non-ACD interactions
Average agent positive score
Average agent negative score
Average customer positive score
Average customer negative score

You also can add or remove agents into this view by right clicking in a blank area and choosing 
Add/Remove Agents
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Workgroup Views - Agent Details Workgroup Views - Agent Details

The Agent Details view will allow you to see the details of one specific agent. The process of 
adding a view is always the same.
1. Start on the Workspace you would like to add the View.
2. Click on the New button
3. Change the Group by to Categories (if necessary)
4. Choose Agents and Workgroups
The View is called Agent Details, after selecting it you will click the OK button.

The Agent Details Wizard will open.
If you have access to many Workgroups you will have to filter to find the correct one using the 
text field at the top. For example, if I am looking for a Agent within an OCIO workgroup I would 
type OCIO in the filter field to find the correct group.
You can also start typing the agents name to filter the list.

If you would like to specify a specific Workgroup that the agent is in then you would click the Next 
button and select the Workgroup otherwise once you find the correct agent select their name and 
click the Finish button. 
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Workgroup Views - Agent Details

The View will then be added to your Workspace. You will notice at the top of the View you have two drop down lists available to you. The first is the 
Agent list. The second is the Workgroup list.
The Agent list can be dropped open and used to select a different agent to display the details of. 
Please remember if you have access to multiple object you will need to filter the list as before by 
typing in the workgroup or agent name.

Workgroup Views - Agent Details

The Workgroup list can be dropped open so that you may specify a different Workgroup than the 
one that is currently displayed that your agent is part of.
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Workgroup Views - Workgroup Overview Workgroup Views - Workgroup Overview

The Workgroup Overview view will allow you to see a rolled-up statistical view on selected 
workgroups.
Within the New View window you will select the Workgroup Overview option and click the OK 
button.

This will open up the Workgroup Overview window where you will need to select the appropriate 
workgroup. Please keep in mind that if you have access to many different groups you will have 
to filter the list using the text field at the top. For example if I am looking for a Workgroup in the 
OCIO I would type OCIO in the filter field to find the correct group.

Select the Workgroup you would like to have in the view and click the Add button. Alternatively 
you can also click Add All to add all of the workgroups.
Once the groups have been selected you will click the Next button.

The next portion of the wizard will ask you to select the statistics you would like to have appear in 
the view. Please keep in mind the more information you choose to display the more cluttered your 
view will be.
1. Select the statistics that are relevant to the selected workgroups for the information 

that you currently need to display.
2. Click the Add button. Alternatively you can click the Add All button but this is REALLY 

not recommended in this view.
3. Click the Next button.
If you are uncertain of a statistic and what it will display you may hover over the entry and a tool 
tip will appear to provide you with a description of the statistic.
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Workgroup Views - Workgroup Overview Workgroup Views - Workgroup Overview

The next screen allows you to modify the intervals that will be displayed and any additional queue 
statistics. The more information you add the more cluttered your view can become.

Once the correct information has been selected click the Finish button to see your new view.

With Workgroup Overview you can easily add and remove workgroups so you can do a side by 
side comparison of their current statistics.
1. Right click a blank area.
2. Select Add/Remove Workgroups.

3. Filter for the appropriate workgroup and click the Add button.
4. Click the OK button.
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Workgroup Views - Workgroup Statistics Workgroup Views - Workgroup Statistics

The Workgroup Statistics view allows a supervisor to have a drill down view showing the live 
statistics of a particular workgroup.
1. From the New View window select Workgroup Statistics.
2. Click the OK button.

The next screen will require you to choose the appropriate workgroup. Please keep in mind that 
if you have access to many different groups you will have to filter the list using the text field at the 
top. For example if I am looking for a Workgroup in the OCIO I would type OCIO in the filter field 
to find the correct group. Once the correct group is selected click the Finish button.

The Workgroup Statistics View will be added to your workspace. This view will show you all of 
the statistical details of your work group. The view is broken into 4 sections separated by a grey 
banner for each section. The sections are:

• Workgroup Statistics
• Queue Statistics
• Service Level Distributions [Cumulative]
• Abandon Rate Distributions [Cumulative]

Clicking on any banner will collapse or expand that section.

You may also look at any other Workgroups you have access to by using the drop down list at the 
top of the view to change the Workgroup
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Workgroup Views - Workgroup Details

The Workgroup Details View provides a drill down interface for you to see all of the statistics of 
a particular Workgroup. This view is very similar to the Workgroup Statistics view but also pro-
vides the ability to see the current live details of the queue and the members of the workgroup 
with their details, such as their current status.
From the New View Window select the Workgroup Details option and click the OK button.

The next screen will require you to choose the appropriate workgroup. Please keep in mind that 
if you have access to many different groups you will have to filter the list using the text field at the 
top. For example if I am looking for a Workgroup in the OCIO I would type OCIO in the filter field 
to find the correct group. Once the correct group is selected click the Finish button.

Workgroup Views - Workgroup Details

The view will then be added to your current workspace. This view is a common view for a super-
visor to use to see what is going on in a particular workgroup for current live statistics.

The top portion of the view is identical to the Workgroup Statistics view and clicking on the differ-
ent headers allows you to drill down and see details.
The bottom portion of the view allows you to see the Queue itself (the interactions waiting in the 
Workgroup) and the members of the Workgroup. You can flip between the two by using the tabs 
on the left side.Queue

Members
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Workgroup Functions - Call Control

Within some of the views you add you will be able to see current interactions. For example in the 
Workgroup Details view the bottom portion of the screen shows the queue of the workgroup.

Using this portion of the interface a supervisor has the ability to use Call Control buttons to inter-
act with the interaction the agent is working with.
By clicking on the interaction and making it the “active” interaction the Call Control buttons across 
the bottom of the view will become enabled. A supervisor will have the ability to:

• Pickup a waiting interaction
• Disconnect the interaction
• Transfer the interaction somewhere else
• Join the interaction
• Listen to the interaction
• Coach an agent through the interaction
• Record the interaction (all interactions are recorded but this will allow a 

supervisor to manage the recording)
• Pause the recording

Workgroup Functions - Membership Activation

As a Supervisor you also have the ability to manipulate your agent’s workgroup activation. If an 
agent is activated in a Workgroup they can take ACD Interactions and if they are deactivated they 
will not receive ACD Interactions.
1. Right click the user in the workgroup.
2. Select Manage Workgroup Activations.

This will open the Manage Workgroup Activations window.
3. Select the user on the left side of the window.
4. Click the Remove button.
5. Remove any other users necessary.
6. Click the OK button.
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Workgroup Functions - Change User Status

CIC knows how to interact with your agents based upon your agents current status. There may 
be times you will need to modify the status that an agent is in.
1. Right click the user.
2. Select Change Status for...

3. Set the Status field to the appropriate status.
4. Click the OK button.

Organizing Views

So far we have taken a look at some of the different views available to Supervisors. These views 
are all organized with in Workspaces. Every view we have created has been placed in the default 
workspace and can be accessed as tabs across the top of the workspace.

Views

Workspaces
You can create multiple Workspaces by using the New button or you may choose to have mul-
tiple views display at once on one workspace. This can be done by left clicking and dragging tab 
header until the zones image appears. Hover over the different zone to see where the tab will be 
placed. Let go on the zone you wish to place the tab. You can also drag tabs to any order or drag 
the tab off the workspace to be by itself.



January 2016 January 2016CIC 2016 Business Manager - Supervisor CIC 2016 Business Manager - Supervisor

Office of the Chief Information Officer The Ohio State University Office of the Chief Information Officer The Ohio State University

Page 30 Page 31

CIC Business Manager - Supervisor CIC Business Manager - Supervisor

Organizing Views Alerts

This will allow you to see tabs side by side.

Another option to see multiple views is to utilize the Slideshow mode. This will rotate the active 
View. This is a feature that would be helpful in a service desk monitoring station.
1. Click the View menu.
2. Select Show slide show

Alerts can be created to notify when a statistic is in or out of a user-defined range, based upon 
the value of the statistic.
Alerts can play sounds, change the color of text or an icon, send an email or send a Supervisor 
Message.
The easiest way to create an alert is to right click the statistic you would like an alert on and 
choose Edit Alerts.

This will open the Edit Alerts window and this will pre-fill the agent/workgroup and statistic fields 
on the Edit Alerts dialog box.
Click the Add button to tell the alert what to do.
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Alerts Alerts

Once inside the Alert window you will need to:
1. Specify the Alert Condition.
2. Specify the minimum and maximum values
3. Set a severity if necessary (this is a colored status icon)
4. Click the Add Action Button.

This will open the Add Action window where you will first need to specify the action the alert will 
need to take. The options are:

• Show the statistics with a different font and color
• Plays a sound on the computer that runs supervisor
• Sends an email to one or more participants
• Runs a custom handler
• Sends a client memo to select recipients.

Depending upon the action you choose the next window will display different options that you will 
need to set. In this example we will look at Show the statistic with a different font and color.
1. Set the Text color
2. Set the Background color.
3. Set Font weight.
4. Click the OK button.

Once your criteria have been met the alert will launch. In this example we have set the alert to 
display when the Longest talk time reaches greater than 8 minutes.

Note
Supervisor Messages 
are an excellent alerting 
feature. Your service 
desk needs Supervi-
sor Message creation 
permissions setup by 
Administrator.
This action sends mes-
sages to the bottom of 
the .NET client or as a 
‘Desktop Pop-up’ (or 
toast).

For example, you could 
set an alert on Interac-
tions Waiting > 20 to 
send a Supervisor Mes-
sage to agents that are 
currently deactivated 
to tell them to activate 
themselves in the 
workgroup to assist with 
volume.
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Assistance Response Reports - Historical

Agents will have the ability to request Supervisor Assistance from within the CIC Client. As a 
Supervisor you will need to know how to handle the incoming assistance requests.
Workgroup Supervisor associations are configured in Interaction Administrator in each work-
group. 
In order for the request assistance process to work properly, at least one supervisor must be con-
figured for your workgroup in Interaction Administrator on the Roles/Supervisor tab and at least 
one supervisor for your workgroup must be logged in. 
Supervisors receive assistance requests only if they are running IC Business Manager. They do 
not receive assistance requests if they are running only Interaction .NET Client.
When an agent needs help and sends a Assistance Request, a toast pop opens on the Supervi-
sors screen

The supervisor can either click Respond or Ignore the request in the toaster pop or Agent As-
sistance window.
If an supervisor ignores the request, the Assistance Request stays active and can pick it up at 
another time or another supervisor can pick up the request.
Multiple supervisors can join an Assistance Request.
When a request is accepted, a chat window opens with the agent and the supervisor can chat 
with the agent .
Telephony options are available as well if the supervisor needs to join the call, listen in, or coach 
the agent.

Running reports on the work your service desk has performed is critical for staffing and standards 
purposes. Business Manager has many different historical reporting features available to you.
To start a Historical Report you will create it as you did a new View.
1. Select the Interaction Reporter Workspace on the left side of your screen.
2. Look for the Navigation Pane showing a listing off the Historical Reports you have ac-

cess to. If the Navigation Pane does not appear you can turn it on using the View Menu 
and selection Navigation Pane.
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This will open a view that contains a listing of the different on demand historical reports that are 
available to you.
1. Click the plus sign + to the left of the name of the report to expand it open and see 

more details about the report and its capabilities.
2. Select a report by double clicking on the name of the report in the list. 
3. You can also right click the name of the report and choose Open Filter.
4. Expand and/or scroll to the Description column to see the contents of the reports.
5. Start the report by double clicking on the specific row.

Reports - Historical Reports - Historical
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Reports Reports

NOTE
The final parameters 
always need to be in 
the lower boxes on 
each tab.

Reports are easily accessible from the Navigation Pane on the left side of your screen. To turn on 
the Navigation Pane:
1. Select the View Menu
2. Select Navigation Pane
3. Select Normal

This will open the panel. Change to the Interaction Reporter Workspace to see a listing of all of 
the available reports.

The Navigation Pane will populate with all of the different reports available for you to use. How to 
use the reports is the same from report to report to report. Which report you run and the pa-
rameters you provide will vary depending on your job role and the information you are trying to 
retrieve.

To run a report you can either double click the report name or you may right click the report name 
and choose Open Filter. This will open the report parameters as a view with the name of the 
report as the name on the tab.

The parameter options will vary from report to report but the process of setting them is the same 
regardless. In this example we can see the parameters for a User Availability Detail Report.

Some parameters are required in order for a report to run. The majority of all reports you see will 
require you to specify a date range. The default setting is always Today, however it can be set to 
any range you require. To set a data parameter you will click on the date menu to open the date 
menu and select the relevant date range.
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Reports Report Assistant

The Report feature is a robust system and contains many of the reports a supervisor would need 
to run. Sometimes however you may find that you need a little more control or different statistics 
to show. The Business Manager has the Report Assistant feature to assist you with creating ad 
hoc reports and queries.
From the New View window you will choose the Historical Reports category and the New Inter-
action Report Assistant option.

Reports may also allow you to add Additional Parameters. The options available to you will vary 
from report to report. Additional Parameters will appear in the Additional Parameters section. 
1. Click the Additional Parameters button and a menu of parameters becomes available.
2. Select the appropriate parameter.

3. Place a value into the parameter field.

4. Click the Run Report button at the top of the screen

The report will open as a view and you can read the content of your report.

Some reports can be modified after being ran. In this example you can change the Workgroup 
you are viewing the details of by changing the Workgroup field at the top of the page.
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Report Assistant Report Assistant

This will launch the Report Assistant Wizard.
The first screen explains the tool and allows you to click Next, Cancel or Help.

The second screen of the wizard allows you to base your report off of the existing options in the 
pre-built reports. As you select the available packages with the first drop down list you will receive 
a tool tip explaining the package.
You will also need to specify if you would like to view your data as a basic table or a matrix (like a 
cross tab query).
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Report Assistant Report Assistant

The next screen allows you to choose the fields you would like to have appear in your report. The 
fields of course will vary depending upon the data package you chose on the previous step.
1. Select the fields you would like to see.
2. Click the right pointing arrow to add them to the right side of the screen. Click the left 

pointing arrow to remove them.
3. Once they have been added click the Next button. Please keep in mind the more fields 

you add the more cluttered your report will appear.

Dependant upon the report the next screen will further modify the parameters of the report. You 
will need to specify the workgroup and/or the users you would like to base the report on.
1. You will need to set the Site ID (normally 1 or 2) and specify the workgroup.
2. Click the Add button. This will add all of the users of that site in that Workgroup to the 

report.
3. Click the Next button.
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Report Assistant Report Assistant

Depending upon the report the next screen may ask you to specify a filter such as a Date range.
1. Set the filters.
2. Click the OK button.

Depending upon the report the next screen may allow you the option of specifying grouping levels 
and summaries. If you would like to add any of these to your report set them now.
1. Put a check in the box of the filter option.
2. Change the Summary Type field to an appropriate value.
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Report Assistant Report Assistant

After setting all filters, data and parameters eventually you will get to the last page of the wizard. 
This is a summary screen to remind you of all of the options you made. 
1. Choose whether your report will be portrait or landscape orientation.
2. Click the Finish button.

The report will then be generated and you can see the results of your work! You may use the tool 
bar at the top of the report to navigate page to page, refresh the report, print and search.

You can also Use File > Save As if you wish to save the report for future re-use.
Or use File > Recent Files to load a previously saved report.



January 2016 January 2016CIC 2016 Business Manager - Supervisor CIC 2016 Business Manager - Supervisor

Office of the Chief Information Officer The Ohio State University Office of the Chief Information Officer The Ohio State University

Page 50 Page 51

CIC Business Manager - Supervisor CIC Business Manager - Supervisor

Retrieve Call Recordings Retrieve Call Recordings

Retrieving recorded calls is accomplished in the Interaction Recorder workspace. To access the 
workspace click the Interaction Recorder workspace tab on the left hand side of your screen.

The Navigation Pane will update to show a Public Search and a Private Search folder. Any saved 
searches you have created will be listed here. To create a new search right click the Private 
Search folder and select New and then Recording Search.

This will open the Create Recording Search window. You need to specify a name for the search, 
the maximum number of results you would like to have appear, and the necessary attributes to 
restrict the calls you retrieve.

To add attributes you will click the New Attribute button and choose a category of attribute. You 
can specify as many attributes as you need to in order to narrow down your search results.

Once all of your attributes have been set you will click the Create Search button to complete the 
Search.
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Retrieve Call Recordings

Your search will appear and it will be saved for future use in the Navigation Pane.


